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Introduction

Thank you for choosing Turbonomic, the Intelligent Workload Management solution for Cloud and Virtualized Envi-
ronments. This guide gives you information you need to install Turbonomic in your virtual environment, install your 
license, and get started managing your resources.

If you have any questions, please see our support site at https://support.turbonomic.com.

Sincerely:

The Turbonomic Team
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Minimum Requirements

You can run Turbonomic on hosts that meet the following minimum requirements:

NOTE:  Minimum requirements depend on the size of your environment's inventory. The more datastores, 
hosts, VMs, and applications you have, the more resources you need to run the installation effectively. Also note 
that other management software might recommend that you run the Turbonomic VM with lower resources. 
Please be sure to give Turbonomic enough resources, using the guidelines above.

Turbonomic supports DHCP or static IP addressing. For information about using static IP addresses, see Specifying a 
Static IP Address on page 7

Supported Hypervisors Storage Requirements Memory CPUs

VMware vCenter versions 4.x, 5.x, 6.0 
running with ESXi 3.x, 4.x, 5.x, or 
6.0

150GB or greater disk storage + 
swap space to match the RAM 
allocation (for example, 150GB + 
16GB = 166GB)

16 GB 2 vCPUs — 4 vCPUs 
preferred

Citrix XenServer versions 5.6.x and 6.x 150GB or greater disk storage

Microsoft Hyper-V as bundled with Windows 
2008 R2, Hyper-V Server 2012, or 
Hyper-V Server 2012 R2

Red Hat 
Enterprise 
Virtualization

RHEV 3.x,
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Installing Turbonomic

As you get started with Turbonomic, please note that there are different downloads available for the supported 
hypervisors. These downloads all deliver the same version of Turbonomic with the same capabilities, but they are 
packaged to install and run on different hypervisor platforms.

NOTE:  The most common delivery of Turbonomic in the past has been a VM with x86 architecture, and that runs 
openSUSE as an OS. Turbonomic has recently begun the process of migrating from openSUSE to CentOS.

Starting with version 5.7, Turbonomic OVAs will be released on CentOS. Turbonomic recommends that 
customers migrate from openSUSE to CentOS as soon as reasonably possible. The deployment process is 
no different compared to openSUSE OVAs.

You can also install the Turbonomic software on a VM running Red Hat (see Installing and Updating on a RHEL 
Platform on page 18).

Each installation manages virtual environments in exactly the same way. The installation you choose depends on the 
policies and standards for your enterprise. This document describes installation procedures for each of the Turbo-
nomic downloads. The installation you choose has no effect on the technologies you can manage with Turbonomic. No 
matter which type of machine hosts Turbonomic, you can manage all workloads running on the supported hypervi‐
sors, as well as those managed via cloud platforms and load balancer targets.

note:  This section describes how to install a new Turbonomic server. If you are updating a current installation 
to new version, you should not perform a full install — Instead you should update your current installation. See 
Updating Turbonomic to a New Version on page 11. Before you perform an update, you should make sure you 
do not need to perform a migration, which includes migration of your historical and configuration data. Check 
the release notes for migration requirements, or refer to the list of migration points in this document. For more 
information, see Migrating to a New Turbonomic Distribution on page 14.

This section includes installation instructions for the following supported virtual platforms:

• Installing on VMware Systems on page 3
• Installing on Citrix XenServer on page 4
• Installing on Microsoft Hyper-V on page 5
• Installing on RHEV Systems on page 5
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Installing on VMware Systems

This download of the Turbonomic server is in the .OVA 1.0 format. vCenter Server versions 4.0 and earlier do not 
support the import of .OVA 1.0 files. If you install this download on such a system, you will see a warning similar to 
the following:

If you choose one of these earlier versions of vCenter Server, please contact Turbonomic Support to receive the instal-
lation package in a compatible format.

To install Turbonomic:

1. Download the Turbonomic installation package.

The email you received from Turbonomic includes links to the Turbonomic download pages.

2. Import the OVA file into your VMware infrastructure using VCenter.

3. Boot the Turbonomic appliance and record its IP address.

Users navigate to the appliance IP address to start up the Web User Interface in a browser.

4. If necessary, specify a static IP address for the appliance.

If your environment does not have DHCP, or if you want to give the Turbonomic server a static IP address, see Spec-
ifying a Static IP Address on page 7.

5. Perform the required configuration steps for the Turbonomic VM.

After you install the VM, you must ensure that its system clock is synchronized, and that you have opened the 
correct communication ports. For more information, see Synchronizing Time on page 8and Opening Ports on 
page 8.

Installing on Citrix XenServer

1. Download the Turbonomic installation package.

The email you received from Turbonomic includes links to the Turbonomic download pages.

2. Unpack the gzip file to a machine that can be accessed by the XenCenter import operation.

3. In the XenCenter application, chose File > Import to open the Import Wizard.

4. Step through the Wizard to provide the following information:
• The location of the Turbonomic server you want to import
• The home server you want to import Turbonomic into
• The storage repository that provides disks for the Turbonomic server
• Virtual network interfaces for the server
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5. Click Finish to import the Turbonomic VM.

6. Boot the Turbonomic appliance and record its IP address.

Users navigate to the appliance IP address to start up the Web User Interface in a browser.

7. If necessary, specify a static IP address for the appliance.

If your environment does not have DHCP, or if you want to give the Turbonomic server a static IP address, see Spec-
ifying a Static IP Address on page 7.

8. Perform the required configuration steps for the Turbonomic VM.

After you install the VM, you must ensure that its system clock is synchronized, and that you have opened the 
correct communication ports. For more information, see Synchronizing Time on page 8and Opening Ports on 
page 8.

Installing on Microsoft Hyper-V

1. Download the Turbonomic installation package.

The email you received from Turbonomic includes links to the Turbonomic download pages.

2. Expand the zip file and copy the contents to your Hyper-V server (either to your cluster shared volume or to a 
local hard drive).

3. Use the Hyper-V manager to import the files into your environment.

4. Make sure your virtual network adapter is connected to the correct virtual network

5. Ensure the Turbonomic VM will have sufficient memory.

Turbonomic recommends that you use static memory for your Turbonomic server. However, you can specify static 
or dynamic memory for the VM.

In Properties for the VM, navigate to Hardware Configuration:
• For Static Memory, set Virtual machine memory to at least 16GMB.
• For Dynamic Memory, then set Startup memory and Minimum memory to 16GB.

6. Boot the Turbonomic appliance and record its IP address.

Users navigate to the appliance IP address to start up the Web User Interface in a browser.

7. If necessary, specify a static IP address for the appliance.

If your environment does not have DHCP, or if you want to give the Turbonomic server a static IP address, see Spec-
ifying a Static IP Address on page 7.

8. Perform the required configuration steps for the Turbonomic VM.

After you install the VM, you must ensure that its system clock is synchronized, and that you have opened the 
correct communication ports. For more information, see Synchronizing Time on page 8and Opening Ports on 
page 8.

NOTE:  The Turbonomic VM’s configuration includes a NIC that is not connected to any network. After installing 
the VM, you should use the Hyper-V Manager to configure the network and VLAN settings to suit the require-
ments of your cluster’s network.
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Installing on RHEV Systems

Turbonomic distributes the Turbonomic server as TGZ archives. RHEV provides a utility named rhevm-image-
uploader that you must use to upload and import the server to a system in the RHEV environment. This utility must 
be installed before you can use it. For more information, please refer to the RHEV portal article, RHEV: How do I use an 
appliance downloaded from the Market Place? You can find this article at:

https://access.redhat.com/knowledge/articles/67891.

The following steps assume you have rhevm-image-uploader installed and configured, and that you have iden-
tified the export domain you will upload the VM to.

1. Download the Turbonomic installation package.

The email you received from Turbonomic includes links to the Turbonomic download pages.

2. Upload the TGZ file to the identified export domain via the rhevm-image-uploader utility.

Execute the following command:# rhevm-image-uploader -e <export_domain> --name <name> 
upload <filename.tgz>
where <export_domain> is the name of the export domain, and <name> is the name of the VM you want to 
create for the Turbonomic VM. You must execute this command on a system that can mount the NFS export 
domain.

3. Import a VM from the package into the export domain.
• Open the RHEV admin interface and display the Storage tab
• Locate and select the identified export domain, and click Import
• In the confirmation dialog that appears, click OK

The import operation may take some time — import runs in the background. When the import process is done, an 
event "Vm <name> was successfully imported" will appear under the Events tab.

4. Attach the Turbonomic VM to the “rhevm” network.

The rhevm-image-uploader tool does not create any network interfaces. You must manually create a network 
interface and attach the VM to the rhevm network.
• In the RHEV admin interface, display the Virtual Machines tab
• Locate and select the Turbonomic virtual machine you just created
• Click Network Interfaces and then New
• Use the provided default values and click OK

5. Boot the Turbonomic appliance and record its IP address.

Users navigate to the appliance IP address to start up the Web User Interface in a browser.

6. If necessary, specify a static IP address for the appliance.

If your environment does not have DHCP, or if you want to give the Turbonomic server a static IP address, see Spec-
ifying a Static IP Address on page 7.

7. Perform the required configuration steps for the Turbonomic VM.

After you install the VM, you must ensure that its system clock is synchronized, and that you have opened the 
correct communication ports. For more information, see Synchronizing Time on page 8and Opening Ports on 
page 8.
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General Configuration Requirements

After you install the Turbonomic VM, you must configure the machine’s clock, and ensure that you have opened the 
ports Turbonomic needs to communicate on your network.

Specifying a Static IP Address

Optional

Many installations use DHCP for dynamic IP address allocation. You can also specify a static address via the virtual 
machine’s IP configuration. Turbonomic includes a script to assist you with this. As root, run ipsetup from the com-
mand line. If you need to execute the action manually, follow the steps listed:

NOTE:  If you are configuring static IP for an installation running on a XenServer VM, use the instructions in the 
following support article: https://support.turbonomic.com/hc/en-us/articles/
200681546

To specify a static IP address:

1. Open a console window to the Turbonomic VM, using the SSH user created during installation

2. Execute the nmtui command

This opens up the UI for the NetworkManager. Select Edit a connection

3. Select the Add option on the screen that appears

This opens a dialog box entitled New Connection

4. Select Ethernet from the list of options and fill out the following information (values given are examples 
only):
• Profile Name: eth0
• Device: eth0
• IPv4 Configuration: <Manual>

Select <Show> and fill out the Configuration sub-settings based on your environment
• Select <Ok> to be returned to the configuration list

5. Verify that the connection you just created is present
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6. Select <Quit> to return to the command line

7. Execute the following command to restart the network services: service network restart
The network service should be restarted successfully and your machine should now be reachable at the IP address 
that was configured. This can be confirmed by executing the ifconfig eth0 command.

This applies the IP address you specify to the Turbonomic VM. You can now access the Web user interface via this IP 
address.

Synchronizing Time

It is important that you synchronize the clock on the Turbonomic server with the devices on the same network. You 
will specify the timeserver or servers that Turbonomic will use to synchronize its clock.

You should also set the system clock to your current time zone. Turbonomic runs regular data maintenance processes. 
To minimize performance impact, it runs these processes at night. To ensure that these processes run at the proper 
local time, you should synchronize the VM with your local time zone.

Turbonomic includes a script to assist you with this. As root, run timesync from the command line. If you need to 
execute the action manually, follow the steps listed:

1. Open a console window to the Turbonomic VM, using the SSH user created during installation

2. Execute the vi /etc/chrony.conf command

This opens up the configuration file for chrony.

3. Replace the timeservers found at the bottom of the file with your timeservers.

4. Execute the systemctl restart chronyd command.

This restarts the chrony service.

Opening Ports

Required

To use Turbonomic in your environment, you should open the following ports:

For browser connections with the server, you should use either port 80 or 443.

NOTE:  Various targets that you use with Turbonomic may require you to open ports on those target servers to 
allow communications with Turbonomic. For more information, see the Turbonomic Target Configuration Guide.

Port: To support:

80 Incoming browser connections over HTTP

443 • Incoming browser connections over HTTPS
• Proactive Support (automatically generate support tickets for Turbonomic issues)
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Enforcing Secure Access

Turbonomic enables you to install a trusted certificate from a known certificate authority. For more information, 
including detailed steps, see https://greencircle.vmturbo.com/docs/DOC-4630
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License Installation and First-time 
Login

To use Turbonomic, open a Web browser to the IP address of the installed VM.

1. Connect to your Turbonomic server via a Web browser.

2. Log into Turbonomic.

By default you can use the following credentials:
• Username: administrator
• Password: vmturbo
As you perform the initial login, you will be prompted to change the password for the administrator account. 
To continue, provide a new password for this account.

3. Install your license.

For a first run of the Turbonomic product, you will see a wizard that directs you to install your license:
• If you have already received a license, choose I have a license for full product and continue with the wizard. 

At the License Page of the wizard, copy-and-paste your license key information (sent to you in a separate 
email) into the license window. Then complete the wizard.

• If you want to try out the full-featured product for 30 days, choose I would like to request a license for a 30-
day trial. Or to try the Virtual Health Monitor edition, choose I would like to request a license for the free 
Virtual Health Monitor.When you continue, the wizard displays a form you can fill out to request a license. 
Turbonomic will send you an email message with the license data. Copy and paste your license key information 
into the license window, and then complete the wizard.

You can also apply or change a license outside of this wizard interface. Log into Turbonomic and display the Admin 
view. Then click License Configuration and copy-and-paste your license key information in the license window.

Depending on which license you have installed, the license enables either a trial or a full unlimited license for Turbo-
nomic. A trial license enables one of the following:

• Workload Edition Turbonomic (30-day trial)
• Application Edition Turbonomic (30-day trial)
• Cloud Native Edition Turbonomic (30-day trial)
• Virtual Health Monitor (six month trial, renewable)
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At the conclusion of the trial your license will expire. When you next log into Turbonomic, the License wizard appears 
— you can then request a Virtual Health Monitor license. If you were unable to complete your evaluation within the 
trial period, feel free to send a request to evalTeam@vmturbo.com. We will be happy to arrange an extension for 
you.

The Virtual Health Monitor enables the monitoring and reporting features of Turbonomic. Each Virtual Health Moni-
tor license period lasts six months. You can renew this license once to get another six months of use.

Upgrading your Turbonomic License

If you purchased a license to upgrade from a trial version to a full version, or if you purchased a license to add control 
modules to your installation, you will receive a new license in an email message. To install this new license, display the 
Admin tab and click License Configuration. Then copy/paste the license key information into the license window.

The new features will automatically become available to you once you install the new license.
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Updating Turbonomic to a New 
Version

IMPORTANT:  ONLY PERFORM THESE UPDATE STEPS IF YOU ARE SURE YOU DO NOT NEED TO MIGRATE TO A 
NEW DISTRIBUTION. It is important to verify that you do not need to migrate to a newer Turbonomic VM distri‐
bution. For more information, see Migrating to a New Turbonomic Distribution on page 14.

We continually and rapidly innovate and improve all aspects of Turbonomic. This means that we periodically release 
newer versions of Turbonomic. You should check regularly to see if a new version is available.

When a new version is available, it’s important to properly update your existing installed server, rather than just install 
a new one. When you first installed Turbonomic, you put into place sophisticated data collection and analysis pro-
cesses. Internal to the installation is an integrated database that retains performance data from across your virtual 
environment. Turbonomic uses this historical data for right-sizing, projecting trends, and other analysis. This means 
that the database is important to Turbonomic and becomes more so over time. Properly updating your installation of 
Turbonomic preserves the database for continued use.

For free evaluation versions of Turbonomic, these installations also use the database, even though the more advanced 
functionality based on this data might not be not available. If you later install a higher level license, the newly added 
features can use the stored data.

To update your Turbonomic installation:

1. Ensure your server has external Internet access.

External access is necessary to perform an online update. If your installation doesn’t have external Internet access, 
navigate to the following location to get started with an offline update:

https://greencircle.turbonomic.com/docs/DOC-1292.

2. Save a snapshot of your current Turbonomic VM.

Before updating, you should properly shut down (not power off) the Turbonomic VM and perform a snapshot (or 
clone the VM). This provides a reliable restore point you can turn to in the event that trouble occurs during the 
update. After you have the snapshot, bring the VM back online.

3. Check the version of your current installation, and check to see whether a new version is available.

To check for newer versions, navigate to the Admin view and show the Maintenance work flow. In the Software 
Updates section, click Check to compare your current version with the latest available version. 
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The listing shows numbers for the current and available versions of the packages that make up Turbonomic. If the 
listing shows a higher version number for the available version, then you can update your installation.

4. Update your current product to the newer version.

To update your current installation, click Update.

Turbonomic updates automatically, and the update will complete in a few minutes. After refreshing, you will have 
full access to Turbonomic features. However, features that rely on current analysis data will not be available until 
after a full market cycle — usually 10 minutes. For example, the To Do list will not show any recommended actions 
until after a full market cycle.

5. Refresh your browser and update your local Flash cache.

After you perform the version update, each user of the Turbonomic installation should refresh the browser and 
clear his or her local Adobe Flash cache. This ensures that the Turbonomic user interface will be fully refreshed in 
the browser.

To clear the cache the user can open the Flash Settings Manager locally on his or her system, or can access the 
Settings Manager through the following Adobe site: http://www.macromedia.com/support/
documentation/en/flashplayer/help/settings_manager07.html.

To open the Settings Manager locally on the system:
• Windows: click Start > Settings > Control Panel > Flash Player
• Macintosh: System Preferences (under Other) click Flash Player
• Linux Gnome: System > Preferences > Adobe Flash Player
• Linux KDE: System Settings > Adobe Flash Player
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Migrating to a New Turbonomic 
Distribution

IMPORTANT:  PERFORM THESE MIGRATION STEPS ONLY IF YOU INTEND TO MIGRATE TO A NEWER VERSION OF 
THE VM OS AND PLATFORM. Occasionally, a new version of Turbonomic includes improvements that require a 
full installation of a new VM. This new VM will replace your current installation of Turbonomic. Simply updating 
your current installation will not properly migrate your data to the newer version of Turbonomic.

There are occasions when the new version of Turbonomic includes changes to the platform. These changes can 
include an upgraded version of the openSUSE OS, a newer version of the JVM, newer versions of the application con-
tainers that serve up Turbonomic, or changes to the Turbonomic database. The standard Turbonomic Update func-
tions do not replace the platform — to take advantages of these changes you must install a new instance of the 
Turbonomic VM, and migrate your existing configuration and database to that new instance.

To perform this migration, you must first determine what version of the Linux Kernel is running in your installed VM, 
and look that up in the table of migration points included below. If there is a table entry for a newer migration point, 
then you should perform the indicated migration steps.

IMPORTANT:  PERFORM THESE MIGRATION STEPS IF YOUR CURRENT INSTALLATION RUNS ON OPEN SUSE 13.2 
OR EARLIER. Turbonomic 5.7 ships on CentOS 7.3 — If you have not performed a migration to a 5.x version of 
Turbonomic, then you must perform a migration to Turbonomic 5.4. If your current installation has ever hosted 
Turbonomic 4.7 (or earlier), you must replace it with a new VM. In that case, simply updating your current instal‐
lation will not properly migrate your data to the latest version of Turbonomic.

Do I Need to Migrate?

Migrating to a new distribution of Turbonomic is not difficult, but it requires preparation, and it will disrupt your Tur-
bonomic services for a short time. You should not perform a migration unless the latest distribution includes changes 
to the VM that are not in your current installation.
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To determine which version of openSUSE you are running on:

1. Open a secure shell to your Turbonomic machine.

2. Display the os-release file.

In the shell, enter cat /etc/os-release. The result includes your OS version:

3. Enter Control-c to close the file, then log out of the secure shell session.

NOTE:  Starting with Turbonomic version 5.5, to run on an openSUSE platform, the VM must run openSUSE 
version 13.2 or later. If you are running a version of Turbonomic that is earlier than 5.5, and the VM runs an 
earlier version of openSUSE, then you cannot update to version 5.5. You must first migrate to a new installation 
of Turbonomic 5.4, and then you can update to Turbonomic 5.5. For more information, please contact Turbo-
nomic Technical Support.

NOTE:  Starting with version 5.7, the Turbonomic OVA will be available on both openSUSE and centOS. Starting 
with the release of Turbonomic 5.9, the OVA will only be available on centOS. While current openSUSE VMs will 
continue to function, it is highly recommended that you migrate to centOS before that time in order to receive 
the latest security and functionality updates. To migrate, follow the steps below. For more information, please 
see https://greencircle.vmturbo.com/docs/DOC-4276.

OS Version: Action and Description:

Earlier than 12.3 Your VM was installed before version 4.5, and it was not updated. Please contact Technical Support for 
the proper steps to migrate.

openSUSE 12.3 Your VM was updated to the distribution that was released for Turbonomic 4.5. If you are updating to 
Turbonomic 5.0.2, 5.1, or higher, then you should perform the migration steps below.
The new distribution uses openSUSE 13.2, which includes security updates and other improvements. 
In addition, if you have modified your Data Retention policies to significantly increase the amount of 
data stored in the system’s database, this migration can result in performance improvements — 
contact Technical Support if you think this applies to you.
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Migrating to a New Installation

If you have looked up your version in the Migration Points table, and the entry indicates that you should perform a 
migration, then follow these steps:

1. Ensure your VM has external internet access.

External access is necessary to perform an online update. If your installation doesn’t have external internet access, 
navigate to the following location to access the files for an offline update:

https://greencircle.turbonomic.com/docs/DOC-1292.

IMPORTANT:  To perform an offline update to a version that is 4.0 or later, your current build version must be 
22559 or later. If you have a lower build number than that, you must first update to 22559. For more information 
and offline access to the 22559 build, see the following article: https://greencircle.vmturbo.com/
docs/DOC-2181. To perform such an update, please contact Technical Support.

2. Save a snapshot of your current Turbonomic VM.

Before migrating to a later version, you should properly shut down (not power off) the Turbonomic VM and 
perform a snapshot (or clone the VM). This provides a reliable restore point you can turn to in the event that 
trouble occurs during the migration. After you have the snapshot, bring the VM back online.

3. Check the version of your current installation, and check to see whether a new version is available.

To check for newer versions, navigate to the Admin view and open the Maintenance work flow. In the Software 
Updates section, click Check to compare your current version with the latest available version. 

The listing shows numbers for the current and available versions of the packages that make up Turbonomic. If the 
listing shows a higher version number for the available version, then you can update your installation.

4. Update your current installation to the latest version.

Before migrating your data, you must update the current installation to the latest version. The migration involves 
backing up your current installation, and restoring the data to an installation of a new distribution. The backup and 
restore must be performed on installations of the same version.

For update instructions, see Updating Turbonomic to a New Version on page 11.

5. Back up the updated version of your current installation.

NOTE:  You must back up your current installation after you have updated it to the new version.

To perform a backup:
• Establish a console or putty SSH session to the Turbonomic instance

Log in as root. The default password is vmturbo.
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• Execute the backup

Run the following command to create the backup file:

vmturbo:~ # /srv/tomcat6/script/appliance/vmtbackup.sh -o full
The executes a full backup which includes the historical database, retained reports, and the configuration files.

This command saves the backup file to /tmp/vmtbackup.zip.

6. Download and install a new Turbonomic.

You will migrate your backed up data to this new installation of Turbonomic.

See Installing Turbonomic on page 3.

7. Copy your saved backup file to the new Turbonomic installation.

To restore a backup to an Turbonomic installation, you first need to copy the backup file from the original Turbo-
nomic instance, over to the new Turbonomic instance. To do this:
• Establish a console or putty SSH session to the original Turbonomic instance

Log in as root. The default password is vmturbo.
• Copy the backup file to your new Turbonomic instance

Run the following command:

vmturbo:~ # scp /tmp/vmtbackup.zip [IP_addr]:/tmp
For example, assuming the IP address is 10.25.100.115, the command would be:

vmturbo:~ # scp /tmp/vmtbackup.zip 10.25.100.115:/tmp
• Provide your root password

The copy command requests your root password. Provide the password you used to log into this session as 
root (the default password is vmturbo).

The command copies your backup file to the new instance of Turbonomic, to the following location:

/tmp/vmtbackup.zip

8. Restore your saved backup file to the new Turbonomic installation.

WARNING:  Before restoring your backup to the new installation, you must shut down the older installation of 
Operations Manager. This ensures there is only one Operations Manager installation operating in your environ-
ment with the same configuration.

To restore a backup to the new Turbonomic installation:
• Establish a console or putty SSH session to the new Turbonomic instance

Log in as root. The default password is vmturbo.
• Make sure the shell is at the path root

Execute the command:

vmturbo:~ # cd /
• Perform the backup restore

Execute the command:

vmturbo:~ # /srv/tomcat/script/appliance/vmtrestore.sh -o full
This performs a full restore from the backup file. It assumes the backup file is in the following location:

/tmp/vmtbackup.zip.
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9. Verify that the migration was successful

Log into the new Turbonomic user interface and confirm that the migration is complete and successful. Check your 
data in the following views:
• Admin view — check configuration data such as license, user accounts, and target configurations
• Policy view — check your custom groups under Group Management, as well as any placement policies you 

have created under Workload Placement
• Inventory view — check that the date slider on the information panels can show historical data

Note that migration does not update the following items. You might need to manually configure these:
• SMTP configuration that was set up in the Admin > Maintenance view
• HTTP Proxy configuration that was set up in the Admin > Maintenance view
• If you had configured your original Turbonomic instance to use HTTPS protocol only, you will need to configure 

this setting for the new instance of Turbonomic
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Installing and Updating on a RHEL 
Platform

Turbonomic delivers a server that runs on the Red Hat Linux (RHEL) platform installed on a a VM with x86 architec-
ture. This is to support environments for which administrative policies require RHEL.

NOTE:  The most common delivery of Turbonomic is on a VM with x86 architecture, and that runs openSUSE as 
an OS. The openSUSE deliveries include all the necessary components — If an upgrade to the openSUSE platform 
becomes necessary, Turbonomic releases a new delivery that includes the platform update. This section 
describes the less common deployment on a VM running RHEL. For RHEL platforms, you are responsible for 
keeping the platform up to date.

Requirements and Setup

Whether you’re performing a clean install, or updating an already installed version of Turbonomic, you should ensure 
that your platform is up to date with the components that are necessary to run Turbonomic. For a listing of these 
components, see Appendix A: Turbonomic Platform Components on page 24.

In addition, you must run an openJDK version that corresponds with the Turbonomic version you want to run. For ver-
sions later than Turbonomic 5.3, you should use openJDK 1.8.

Turbonomic makes the following setup recommendations for your RHEL VM:

• The VM should have 4 VCPUs and 16 GB of RAM
• You should create a boot partition for the OS kernel, giving it 250 MB
• You should create LVM volumes for the following purposes:

- A swap partition following Red Hat recommendation for partition schemes
- 100 GB for the database on /var/lib/mysql
- 10 GB for system logs to be stored on /var/log/
- 10 GB for system temp storage on /tmp/
- 25 GB for the product installation on /srv
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In addition, the VM must meet the following prerequisites:

• The firewall is configured to allow connections on port 80
• SELinux is configured to allow communication between Apache and Tomcat

Execute the following command:

#setsebool -P httpd_can_network_connect=1
• The unzip utility must be installed

A minimal installation of CentOS6.7 does not include unzip. If necessary, install the utility via:

#yum install unzip

Installation

To create a RHEL deployment of Turbonomic, you will create a VM running RHEL, download a Turbonomic update, and 
install the necessary components. In addition, you will have to modify the directory structure on your VM, make 
changes to the database config file, and start up the services.

1. Create a VM running the RHEL operating system.

2. Install an update of the Turbonomic product on your RHEL VM.

You can configure an offline update or an online update to install the initial version of Turbonomic:
• Offline Update:

You can find links to offline updates on the following Green Circle document:

https://greencircle.turbonomic.com/docs/DOC-1292

When you have identified the offline update version that you want, open a shell with root permissions and 
perform the following commands:

cd /root
curl -O http://download.vmturbo.com/appliance/download/updates/update64_redhat-
XXXXX-X.X.X.zip
cd /tmp
unzip /root/update64_redhat-XXXXX-X.X.X.zip
cp /tmp/vmturbo_temp.repo /etc/yum.repos.d/

• Online Update:

Create a YUM Repository configuration file named vmturbo.repo in the following location:

/etc/yum.repos.d/vmturbo.repo

Give the file the following content:

[vmturbo]
name=vmturbo
baseurl=http://download.vmturbo.com/appliance/download/vmturbo-redhat
type=rpm-md
enabled=1
autorefresh=1
gpgcheck=0
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3. Install other required components.

To install the components, execute the following commands, in this order:
• apache/mod_ssl

yum install mod_ssl
• The Java Runtime Environment

Note that you must install the JRE version that matches the version of Turbonomic that you are installing. This 
example shows installation for JRE 1.8:

yum install java-1.8.0-openjdk
update-alternatives --config java

At the prompt generated by the update-alternatives command, select the version of Java that corre-
sponds to the version just installed.

• The Turbonomic bundle
yum install vmt-bundle --nogpgcheck

4. Set up the correct file structure.

Execute the following commands to set up the required directory structure:

ln -s /srv/www/htdocs /srv/www/html
rm -rf /var/www/
ln -s /srv/www /var/
rm -rf /var/lib/tomcat6/ /var/lib/tomcat/
ln -s /srv/tomcat6/ /var/lib/ ; ln -s /srv/tomcat/ /var/lib/
mkdir -p /var/lib/mysql/tmp
chown mysql:mysql /var/lib/mysql/tmp

5. Edit the database my.cnf file.

Edit the file /etc/my.cnf to make the following settings:

NOTE:  These settings may already exist. If so, the database restart below is still required.

[mysqld]
...
innodb_file_per_table=1
innodb_buffer_pool_size = 1024M
query_cache_size = 64M
query_cache_limit = 8M
tmpdir = /var/lib/mysql/tmp

After editing the file, be sure to restart the database.

service mariadb restart

6. Initialize the database that was installed in the Turbonomic bundle.

Execute the following commands:

cd /srv/rails/webapps/persistence/db/
./initialize_all.sh

7. Start the associated services.

You can restart the VM, or you can execute the following commands to start the services:

service tomcat start
service httpd start
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8. Ensure that time is synchronized between the VM and the physical machine that hosts the VM.

Confirm that the NTP service is running.

For a host that is managed by VMware vSphere, disable the Synchronize Guest Time With Host option for the VM. 
You can find that setting in Options > VMware Tools > Advanced.

Updating the RHEL Deployment

After you have deployed Turbonomic on a RHEL platform, you can update that installation with new versions of Turbo-
nomic as they come out:

• For offline updates, download a new offline deliverable and unzip it to /tmp

Use the following commands to unzip the offline update:

rm -rf /tmp/vmturbo
cd /tmp
unzip update64_redhat-XXXXX-X.X.X.zip

• For online updates, you can execute YUM commands to update the installed components.

To install the updated components, can use the following YUM commands:

yum clean all
yum update vmt-bundle vmt-config vmt-persistence vmt-platform vmt-presentation vmt-
reports birt-runtime

NOTE:  You should be sure the JRE version is compatible with the new Turbonomic version. For information, see 
Requirements and Setup on page 18.
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FAQs

To ensure that you have the most rewarding experience with your evaluation of Turbonomic, we have collected the 
top installation issues that people experience. If you have any further questions, please see our support site at 
https://support.turbonomic.com.

Do I need special software to run the Turbonomic 
client?

Just make sure that you have an up-to-date Flash plug-in installed. If your URL takes you to a blank page, it's possible 
that the Flash plug-in is not installed.

Why can I not execute some of the recommenda-
tions made by Turbonomic?

To automate the Turbonomic recommendations, visit the Policy tab and configure your automation settings. Turbo-
nomic supports the following action modes:

• Disabled — Do not recommend or perform the action
• Recommended — Recommend the action so a user can perform it using the given hypervisor or by other means
• Manual — Recommend the action, and provide the option to perform that action through the user interface
• Automated — Turbonomic performs the action automatically

Some actions are set to Recommend or Disabled by default. To enable execution of these actions, you must change 
them to Manual or Automated.

Some actions- Database application server actions, for example- cannot be executed by Turbonomic. These actions 
will only have Disabled or Recommended as an option.
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For example, the following figure shows how to set all Start and Move VM actions to be Manual.

After applying these settings, the To Do list in Turbonomic will include the option to direct that the software performs 
these actions on request.

Why can I not generate reports on my custom 
SELinux-enabled VM?

After installing Turbonomic on a custom SELinux-enabled VM, you must execute the following command with root 
priveleges in order to generate reports:

setsebool -P httpd_can_network_connect on

If you install Turbonomic using the provided OVA, this step is done for you.
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Appendix A: Turbonomic Platform 
Components

The following listings show the components that Turbonomic requires in order to run on a virtual machine platform. 
Turbonomic currently delivers product builds to run on openSUSE and Red Hat Enterprise Linux (RHEL) platforms. The 
listing titles show the Turbonomic version — RHEL listings include “redhat” in the title, while listings for openSUSE 
don’t show any platform name.

The listings also include persistence bundles that list the components that support database storage in the Turbo-
nomic server. Refer to these bundles as follows:

• MySQL on redhat — vmt-persistence_redhat-5.62.spec
• MariaDB on openSUSE — vmt-persistence-5.62.spec
• MySQL on openSUSE — vmt-persistence-4.99.spec

Components For vmt-bundle_redhat-
5.5.spec
• curl
• ntp
• postfix
• sudo
• zip
• unzip
• tomcat
• httpd
• birt-runtime
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Components For vmt-bundle_redhat-
5.4.spec
• curl
• ntp
• postfix
• sudo
• zip
• unzip
• tomcat6
• httpd
• birt-runtime

Components For vmt-bundle_redhat-
5.3.spec
• curl
• ntp
• postfix
• sudo
• zip
• unzip
• tomcat6
• httpd
• birt-runtime

Components For vmt-bundle_redhat-
5.2.spec
• curl
• ntp
• postfix
• sudo
• zip
• unzip
• tomcat6
• httpd
• birt-runtime
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Components For vmt-bundle_redhat-
5.1.spec
• curl
• ntp
• postfix
• sudo
• zip
• unzip
• tomcat6
• httpd
• birt-runtime

Components For vmt-bundle_redhat-
5.0.spec
• curl
• ntp
• postfix
• sudo
• zip
• unzip
• tomcat6
• httpd
• birt-runtime

Components For vmt-bundle-5.5.spec
• curl
• fillup
• ntp
• sudo
• zip
• unzip
• tomcat
• apache2
• birt-runtime
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Components For vmt-bundle-5.4.spec
• curl
• fillup
• ntp
• sudo
• zip
• unzip
• tomcat
• apache2
• birt-runtime

Components For vmt-bundle-5.3.spec
• curl
• fillup
• ntp
• sudo
• zip
• unzip
• tomcat
• apache2
• birt-runtime

Components For vmt-bundle-5.2.spec
• curl
• fillup
• ntp
• sudo
• zip
• unzip
• tomcat
• apache2
• birt-runtime
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Components For vmt-bundle-5.1.spec
• curl
• fillup
• ntp
• sudo
• zip
• unzip
• tomcat
• apache2
• birt-runtime

Components For vmt-bundle-5.0.spec
• curl
• fillup
• ntp
• sudo
• zip
• unzip
• tomcat
• apache2
• birt-runtime

Components For vmt-persistence_redhat-
5.62.spec
• mysql-server

Components For vmt-persistence-
5.62.spec
• mariadb
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Components For vmt-persistence-
4.99.spec
• mysql
• ruby
• rubygems
• ruby-mysql
• rubygem-rails-2_3
• rubygem-thin
• rubygem-RedCloth
• rubygem-libxml-ruby
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